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MICHIGAN DEPARTMENT OF TRANSPORTATION

DRAINAGE AND UTILITIES GUIDANCE

Preamble

This Document provides guidance to administrative, engineering, and technical staff.   
Engineering practice requires that professionals use a combination of technical skills and  
judgment in decision making.  Engineering judgment is necessary to allow decisions to  
account for unique site-specific conditions and considerations to provide high quality  
products, within budget, and to protect the public health, safety, and welfare.  This manual  
provides the general operational guidelines; however, it is understood that adaptation,  
adjustments, and deviations are sometimes necessary.  Innovation is a key foundational  
element to advance the state of engineering practice and develop more effective and  
efficient engineering solutions and materials.  As such, it is essential that our engineering  
manuals provide a vehicle to promote, pilot, or implement technologies or practices that  
provide efficiencies and quality products, while maintaining the safety, health, and welfare  
of the public.  It is expected when making significant or impactful deviations from the  
technical information from these guidance materials, that reasonable consultations with  
experts, technical committees, and/or policy setting bodies occur prior to actions within  
the timeframes allowed.  It is also expected that these consultations will eliminate any  
potential conflicts of interest, perceived or otherwise.  MDOT Leadership is committed to  
a culture of innovation to optimize engineering solutions.  

The National Society of Professional Engineers Code of Ethics for Engineering is founded  
on six fundamental canons.  Those canons are provided below.  

Engineers, in the fulfillment of their professional duties, shall:  

1. Hold paramount the safety, health, and welfare of the public.  
2. Perform Services only in areas of their competence.  
3. Issue public statement only in an objective and truthful manner.  
4. Act for each employer or client as faithful agents or trustees.  
5. Avoid deceptive acts.  
6. Conduct themselves honorably, reasonably, ethically, and lawfully so as to  

         enhance the honor, reputation, and usefulness of the profession. 
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INTRODUCTION

MDOT Engineering Support Services Unit in partnership with MDOT Hydraulics Unit has 
prepared this software guide for design and analysis of stormwater drainage systems with the 
Drainage and Utilities module of Bentley Systems OpenRoads Designer software, for MDOT 
trunkline projects. This document is intended to be used along with the MDOT Drainage 
Manual. Please refer to the MDOT Drainage Manual for design guidelines, requirements, and 
notes on intended calculation methods. If information that is presented in this document 
conflicts with anything in the MDOT Drainage Manual, the Drainage Manual has precedence.

For questions related to this guidance and/or the use of Bentley OpenRoads Designer 
Drainage and Utilities Software for MDOT projects contact:  
MDOT-Drainage-Utility@michigan.gov

For questions regarding hydraulic design procedures contact the MDOT Hydraulics Unit.

The Drainage and Utilities (D&U) module of Bentley Systems OpenRoads Designer software 
includes tools for storm drainage design and analysis.  

D&U has two drainage calculation options: 

Analysis mode will not change the 
physical characteristics of the storm 
drainage

Design mode may change the physical 
characteristics. 

At this time, MDOT is not recommending the use of the design mode of the program for storm 
drainage layout. 

Drainage and Utilities is not permitted for culvert design. For appropriate software for the 
sizing of culverts please see 5.3.1 in the MDOT Drainage Manual.

The program contains drainage components, feature definitions and flex tables that have 
been configured to follow MDOT standards and methods. These are meant to aid the 
engineer. The engineer is responsible to verify drainage item properties. 

Please note that if your network extends over 100 Inlets in one model you will trigger an 
additional license.

D&U uses the terrain model referenced into a DGN file to display the storm drainage and 
other utilities in 2D and 3D. Drainage structures and conduits are fully integrated in graphic 
and database functions. 

D&U can be used to:  
 Analyze the existing storm drainage for a project site, a single system or multiple 
 Analyze the existing storm drainage and upgrade for a project site as needed/required 
 Analyze proposed storm drainage system(s) for a project site  
 Analyze conflicts between existing utilities and proposed drainage. 
 Report on Spread, Structure Sizes, and Conduit sizes
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SECTION 1 - DRAINAGE AND UTILITIES TOOLS

This guide provides an overview of the D&U tools that are most commonly used for MDOT 
projects. See the Bentley Online Help or contact Engineering Support for commands not 
detailed in this document. 

Drainage and Utilities Interface

To access the D&U tools within 
OpenRoads Designer, select the 
Drainage and Utilities workflow 
from the drop-down list at the 
upper left side of the ribbon. 

This sets the active workflow and 
loads the D&U ribbon. 

The ribbon is organized with Tabs 
and Groups.

Home Tab

Attributes – Shows all attributes that are active

Primary – opens the explorer, properties, attach tools for references and raster files, level 
manager, level displays (common MicroStation tools)

Selection – houses the Element Selection tools, Cut, Paste and Fence tools

Model Analysis – Civil Analysis gives the user the option to analyze various items

Model Import/Export - various import and export options. 

Terrain Import – creates a terrain model from File, Ascii File, Elements, and Point Cloud 

etc., see Bentley Online help for more Terrain options. 

Import Geometry – from various file types. 

Import Utilities – import drainage data from various other software Bentley Online help. 

Export Utilities – export drainage data to various other software, see Bentley Online help
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Layout Tab

The Layout tab allows the user to place utility structures and connect the structures with 
conduits. The utilities can be below the surface, on the surface or above the surface.

Layout - this is the main tool bar used to place utilities, such as drainage structures and pipes.

Place: Nodes, Conduit, Lateral, Gutter, and Catchment - are the tools to place the physical 
locations of the elements of the Drainage Model. These are predominately place with Pre-
defined Feature definition built from MDOT’s Standards.

Profile Runs - are profiles along a series of structures.  Different profiles can be created from 
the Start Node or the Outfall and Links can be added to a profile run. 

Toggles – allows for turning on/off Civil Accudraw and Civil Message Center. Civil message 
center displays errors, messages, and MicroStation commands.

Note: Place Pond and Low Impact Development Tools are not recommended at this time. 
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Analysis Tab 

The Analysis tab sets calculation parameters, standards, constraints, and scenarios for 
drainage items.

Calculation - Contains tools to set up and compute analysis of the Drainage & Utilities 
systems.

Scenarios – contains the Scenario Manager and Scenario Comparisons. 

Alternatives – contains the various hydraulic parameters that can be adjusted within 
the networks. 

Options – contains the analysis calculation options.      

Compute – runs the analysis for the current scenario. 

Validate – checks the network for errors and warnings prior to analyzing the network. 

Calculation Summary – summary of the active network.  

Notifications – displays network warnings or errors.

Analysis Tools – holds the Compute Center (one toolbox for access to calculations), Default 
Design Constraints are set from the MDOT workspace and should be reviewed for project 
specific constraints (i.e. max. spread, conduit slope), Show Gutter Flow will show the path of 
any bypass from catch basins.

Compute Center – this Controls the global Parameters used for drainage calculations 
in the model.      

Show Gutter Flow – shows gutter flow paths within the drainage dgn. 

Default Design Constraints – contains values for gravity pipe, node, and inlet that will 
produce warnings if conditions are not met during analysis.

Analysis Views – contains the flex tables – MDOT specific flex tables for hydraulic analysis 
have been established to mirror desired deliverables, queries can be used to report on 
specific item
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Components Tab

The Components tab is used to establish project specific storm data, drainage 
properties and settings 

Common – Storm Data, contains Global Storm Events and project wide 
parameters including Time of Concentration  

Catalog - access to engineering libraries, inlet – gutter – conduit catalogs, culvert inlet 
coefficients and rainfall curves from csv files.  Prototypes for drainage items are set in 
workspace and can be updated to project specific data if needed.

Trenches - access to template tools – edit template drop – apply linear template for 
trenches used in the design
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Utilities View Tab

The Utilities View Tab tools open views of various drainage properties.

Drawing Views - element symbology allows control how elements and associated 
label are displayed; open profile model generates a view presenting a desired feature 
in profile; open cross section view creates a dynamic cross section of a selection item; 
these are the ORD Modeling tools. These have been preset in the MDOT Workspace. 

Results Views - houses the Flex Tables – MDOT Flex Tables for hydraulic analysis 
have been established and the user can verify the input data and see results for all 
elements of a specific type in a tabular format.

Selection and Query - create, edit, and navigate selection sets; display all queries in 
the current hydraulic model; open the network navigator.

Element Views - Properties displays a dialog box containing selected elements 
associated properties; Utility Properties displays the subsurface utilities and hydraulic 
analysis of a selected element; Prototypes displays and allows edit to default values 
for elements in a network.  Prototypes have been set-up to MDOT Standards, the 
engineer needs to verify the items in the project to ensure correct conditions apply 
(See MDOT Drainage Manual).

Customize - Customize Properties allows customization and changes to default user 
interface; Customize Tooltip allows customization of tooltips that appear when 
hovering over an element.
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Tool Tab

The Tools tab is divided into general tools and project tools.

General Tools 

Utilities Conflicts allows detection of physical clashes and clearances between 
elements within influence area. 

User Data Extensions allows adding data fields to the hydraulic model toolbox. 

Model Builder allows existing GIS assets to construct a new model or update 
an existing model; update descriptions of conduits in the model; branch 
labeling sets the labels of conduits; set feature definition allows setting/locking 
a feature definition. Model builder also serves as a database import 
clearinghouse for the user data extension information. 

Project Tools - houses project defaults, i-model configuration to export drainage 
calculations, project properties, synchronize drawing and annotation tool to label the 
drainage items.
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Report Tab

The Report tab gives the user fast access to various reports for Tables, Civil and 
Drainage and Utilities.

Report - Custom Report allows the user to assemble a wide variety of model input, 
results, graphs, etc. in a customized report.

Tables - access to all Flex Tables and Network Elements Table for the utility project

Civil - access to civil reports such as horizontal geometry report and corridor reports

Drainage - access to various reports and summaries for the drainage design
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Drawing Production Tab

The Drawing Production tab is divided into tables, notes, text, annotation and 
named boundaries, 

Drawing Production tools enables the user to place notes and labels; place and edit 
text; annotate an individual element or an entire model; enables sheet production 
through the Named Boundary tool.
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SECTION 2 - GETTING STARTED

Compile the information and material necessary to complete a drainage 
design.  Required items for a drainage design (existing or proposed) include storm 
data and terrain data for the project.

IDF Tables

The MDOT workspace contains pre-
populated IDF Tables which contain the 
rainfall data from the Drainage Manual. 
The Designer should make sure the 
correct seed file is used and the correct 
rainfall zone is selected.  

The IDF-Tables for the project storm data are located in the Storm Data dialog. The 
options available for use of an IDF-table will be covered later in this manual.
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Terrain

Drainage and Utilities uses the terrain model referenced into a DGN file to display the 
storm drainage and other utilities in 2D and 3D models.   Drainage structures and 
conduits are fully integrated in graphic and database functions.  The data is stored 
in the graphics within the design file (*.dgn file).

Drainage and Utilities can use the elevations from the active terrain, but Drainage and 
Utilities can only work with one terrain; this can make it necessary to merge terrains 
such as existing, LIDAR, point clouds and/or proposed into one terrain.  The designer 
should create a specific “drainage terrain” for use with the drainage layout and 
calculations.

This “drainage terrain” is in its own MicroStation DGN file and is referenced into the 
“drainage” MicroStation DGN file.
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Create Drainage Model (DGN file)

Ensure OpenRoads Designer Connect Edition is set to the correct Workspace and 
Workset.  Create a new *dgn file (2D) exclusively for your storm drainage layout, 
calculations, and utility conflicts.

1.  From the New dialog box, browse to the proper discipline folder, enter the file 
Name.

2.  Change the workflow 
to: Drainage and Utilities
(upper left corner), open 
the Drainage and Utilities 
Model within the Explorer 
dialog box. 

3. From the Home tab use the Attach Tools - References to attach the survey, 
terrain, aerials, and design files as needed.  Turn OFF Levels as needed from the 
individual files.

4.  Set the Active Terrain.  Using the Element Selection tool click on the boundary 
line for the terrain, hover over it, select the tool Set As Active Terrain Model, this will 
make the terrain active and will be used for placing the drainage structures.

5. In the 2D view (Default) override the Symbology and turn off triangles.  Open 
the Default 3D view and set-up as needed to your preference.

6. Save settings.

7.  The Drainage and Utilities 
Hydraulic Engine needs to be 
activated.  From the Layout tab, 
select the Place 
Node command.  This only has 
to be done once per utility model 
to create a hydraulic 
project.  The Program only 
supports One hydraulic project 
per dgn file, but multiple 
systems can be placed and 
calculated.

The You Cannot Undo This Action message box will open, click Yes.  This will 
open and prepare the Drainage and Utilities project in your DGN file, some context 
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menus will pop-up and disappear, wait until completed and your cursor comes 
back.  Now you are ready to place your structures, conduits, catchment areas and do 
your calculations.
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Set Defaults and Constraints

Some project specific properties, defaults and constraints need to be reviewed and 
set for each project, where possible MDOT standards have been set.

1.  Click on the Tools tab and select Options - Drainage.  The Options box opens.

 Hydraulic Model tab: Pipe Length – Use 3D Length?  Make sure this 
is unchecked. 

 Units tab: default unit system for new project is set to: US Customary, make 
sure all units are set correctly.  

Click OK.

2. Click on the Analysis tab and select Default Design Constraints.

The MDOT workspace contains Defaults that are Pre-set. These constraints will 
trigger warnings within the design for you to edit at a later point. 

The constraints have been set to follow the MDOT Drainage Manual where 
possible.  If you want Drainage and Utilities to design your drainage system, it is 
especially important to review Warnings received from these constraints. The 
“Design” Function may change your default parameters. The Drainage and 
Utilities Help menu should be used for each specific explanation of the Default 
Design Constraints topic. Project specific spread requirements may be different and 
may require further review.
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PROTOTYPES

Prototypes allow for entering default values for elements in a drainage network and 
are used to define the hydraulic properties of features.  A prototype works in 
cooperation with element templates and feature definitions to define the 
characteristics of a drainage feature.  The most widely used conduits, gutters, catch 
basins, manholes, cross sections, catchments, and headwalls etc. have been set 
to MDOT Standards.

The properties for existing Features are loaded within prototypes within the items 
Hydraulic Analysis.

Click on Components – Catalog - Prototypes.
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SECTION 3 – LAYING OUT THE DRAINAGE NETWORK

Creating a drainage DGN-file using the 2D seed as described previously will attribute 
items to the feature definitions that contains your feature symbology, level, element 
templates and annotations.  

These feature definitions contain relevant information and properties will be updated 
as needed when feature definitions change.

Inlet Catalog

Needed Inlets inside MDOT workspace should be attached to corresponding Feature 
Definitions. The dimensions of all the inlet nodes (structures) available for design are 
stored in the Inlet Catalog.

Conduit Catalog

Conduits are placed between nodes such as catch basins, manholes and head- and 
endwalls.

The conduit types within the MDOT workspace have been attached to the appropriate 
Feature Definition.

To view the inlet catalog: Click 
the Components tab – Catalog – Inlet 
Catalog 
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Place Node

Turn off the Fill in View Attributes to only see the outline of structures (catch basin, 
etc.), this will help when placing nodes and conduits.

1.  Select the Place 
Node command to lay out the 
drainage structures: catch basins, 
endwalls, etc. 

2. Select the Feature Definition

3.  Click on the reference element for node elevation (active terrain, edge of road, or 
preferably 3D corridor Line) or click reset to type a node elevation, type in 0.00 for 
vertical offset, this can be changed later. Rotate as needed to place.

4.  Hover over the node to enable the context toolbox: properties, utility properties and 
delete. The node can be moved and rotated.

5.  Continue placing more structures (catch basins, end structures or 
manholes).  After you placed the last structure, right click once more, and select 
the Element Selection tool to end the Place Node command.
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Place Culvert End (Node)

1.  Select the Place 
Node command to place a culvert 
end. 

2. Select the Feature Definition

3.  Click on the reference element for node elevation (Use a corridor or a 3D line as 
an elevation reference) or click reset to type a node elevation, type in 0.00 for vertical 
offset.  Rotate as needed to place. 

4.  After the conduit is placed click and hover over the culvert end for the context 
menu, click on properties. 

5.  In the properties box, change the following 

 Use Slope of Surface = False 
 Match Slope of Conduit = True   
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Place Conduit

Conduits are placed between nodes such as catch basins, manholes and headwalls 
and end sections. 

Note: If a structure is deleted all associated conduits connected to the node are 
also deleted.

1.  Select the Place Conduit command, choose the Feature Definition for the pipe 
you want to place.   The Type: is greyed out – this comes from the conduit catalog 
already attached, for Description click on the down arrow to select the pipe size 
(example: 15”).

2.  Follow the prompts: Select Start Node, in the drawing hover your cursor 
over/close to the first inlet (node i.e. catch basin), it will snap to the node where the 
conduit can connect, this is called the Connection Region. Accept (left click).

3.  Select next node to make a connection. Again, hover your cursor close to the inlet 
to connect the conduit to (second node i.e. catch basin). Accept (left click).

4. Continue to place conduits to connect the drainage structures from the first inlet to 
the outlet for the system.   Select the Element Selection tool to end the place conduit 
command. 

5. Conduits will only attach to Nodes of the same Network Type (Storm conduits will 
not link with other networks such as communication, electric, etc.)
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Input Invert Elevations

After completing the layout for the drainage structures and conduits you will enter the 
invert elevations for all structures and conduits, Drainage and Utilities sets conduit 
inverts to the bottom of the structures by default.  

By selecting a placed utility feature, some feature properties can be edited, rotated 
and/or moved in the graphics.  Also, the context toolbox displays and 
offers two options to input/edit utility information: 

Properties - lists the properties 
such as level, color, feature, feature 
definition etc.;  

Utility Properties- lists every 
available hydraulic property 
including user customized 
properties. Note top menu in utility 
properties dialog grants access to 
both menus.  
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Utility Properties

Drainage and Utilities tools represent the merger of two diverse 
technologies.  OpenRoads Designer builds the 3D models of the utilities, but Bentley's 
Haestad technology (StormCAD) executes the analytic modeling for hydraulic and 
utility engineering.

Utility Properties - Node

Click and hover over a node (catch basin or manhole) from the context toolbox 
select Utility Properties, click on the Drainage tab.

Check and edit the physical properties for the node: 

 Elevation (Ground) = Terrain elevation at node 
 Set Rim to Ground Elevation?  False/True 
 Elevation (Rim) = Top of Grate elevation 
 Elevation (Invert) = bottom elevation of structure 
 Update and edit Inlet properties for the node: 
 Inlet Type: set to Catalog Inlet 
 Inlet: click the down arrow and select from the available structures 

The Inlet catalog has been set-up for 
MDOT catch basin standards.  The 
catalog should be available automatically 
when starting the drainage engine. 
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Utility Properties - Conduit

Click and hover over a conduit, in the context toolbox select Utility Properties, click 
on the Drainage tab.

Check and edit as needed the Physical Properties for the conduit: 

 Conduit Type: Catalog Conduit 
 Catalog Class: click the down arrow and select: Concrete, PVC, CMP 
 Size: click down arrow and select size 
 Invert (Start): enter elevation 
 Invert (Stop): enter elevation 
 Has user Defined Length? True (default) or False 
 Length (user defined) enter length 
 Other items will be edited later 

The MDOT Workspace has feature definitions pre-populated for the commonly used 
conduits.
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Define Drainage Areas (Catchment Properties)

Drainage areas are defined using existing and proposed terrains, which can be 
merged with terrains coming from various other sources. 

There are several options to place catchment areas (see Bentley Help): 

 Place Catchments by Picking Shapes
 Place Catchments by Picking Points
 Place Catchments by Flood Fill

Catchment properties include catchment area, runoff coefficient, time of concentration 
types, and time of concentration. Note you may create multiple catchments and attach 
them to the same structure 

Catchment Area

1.  From the Layout 
Tools select Place 
Catchment and select the 
Method that best serves your 
purpose: example Pick Points

2.  From the Feature 
Definition pick the land use 
most appropriate for the 
catchment area: 
example Pavement

3. Multiple land uses may be 
assigned to one Catch basin to 
create an aggregate CN 

For each land use, prototypes have been created that follow the MDOT Drainage 
Manual.  The designer should adjust the Runoff Coefficient (Rational) for the project if 
needed in the Drainage tab in the Properties menu for the catchment area.
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4.  Follow the command prompts: Select First Vertex, Select Next Vertex, (Reset) 
To Complete, Select Outflow, and Select Reference Surface. 

Runoff Coefficient

Runoff Coefficients have been defined as prototypes following the MDOT Drainage 
Manual.   

Time of Concentration

Time of Concentration (Tc) is defined as the time required for a particle of runoff to 
flow from the hydraulically most distant point to the outlet or design point (catch basin 
etc.).  Factors affecting the Tc are length of flow, slope of flow path and roughness of 
flow path. Please see the Drainage Manual for more information. 

Tc Input Types:

 User Defined Tc -where 
the user inputs minutes 
for Tc or

 Composite Tc -where the 
user inputs a data 
collection of Tc’s (Tc Data 
Collection)

Note: Drainage tab allows user to enter project specific data.  

MDOT Feature Definitions are pre-set to values per Drainage Manual. 

Time of Concentration using Tc Data Collection

This follows the Drainage Manual Tc data collection method.
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Placing Gutter Structure

Gutters are the method by which a catch basin bypass flow is assigned to a downhill 
catch basin (inlet).  Gutters only represent the hydraulic relationship between the 
inlets and are not accurate 2D and 3D models.

To display and add gutters to a drainage 
system: 

Turn Off Annotation Scale Lock (it is 
usually turned on by default): Drawing 
Production tab – Drawing Scales 
tools – Annotation Scale Lock 

1. From the Layout tab, select the Place Gutter tool.

2. From the Feature Definition select the Gutter needed for your project.

For Gutters used to calculate spread, for Method select “Trace Slope 
Method” and select Feature Definition “Conduit_Gutter_Terrain”

3. Follow the prompts: Select Start Node.

4.  Select next node to make connection. <Alt> to place curve. <Ctrl> to place 
bends. <Reset> to select start node. Example select the next node.

5. After placing the gutters turn off the analytic symbology under view attributes.
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Placing Profile Runs

Profile Runs are the method used by the Program to both create profiles and analyze 
drainage networks.

To add Profile Run: 

Go to Layout tab – Profile Runs  

You may select Hydraulic Run from 
Outfall or select Hydraulic run from 
Node

1.  For Hydraulic Run from Outfall, select the Feature Definition “SU_Profile_Run” 
by Clicking Feature Definition – Linear – SU - SU_Profile_Run.

2.  Select end Section and The Program 
will create your Profile Runs

3.  To View: Open Explorer- Select 
Drainage and Utilities Model- Click 
Profile Runs.

4.  For Hydraulic run from Node. repeat 
above process but select start and stop 
nodes of your choosing. 

Note: Typically used for profile sheets 
and display purposes. 
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Using Storm Data

Storm Data is a single rainfall curve that represents one rainfall event for a given 
recurrence interval.  Once the storm data is created it can be used globally by 
selecting Global Storm Events.

Select the Components tab and click on 
the Storm Data tool.  

Several methods for specifying storm 
data are available, the User Defined IDF 
Table will be discussed and used. 

2.  Open User Defined IDF Table, Select Project Rainfall Zone Per Drainage 
Manual

3.  Close the Storm Data box. 

4. Select the Tools tab, click Options, Drainage – this will open the Options box.

8.  In the Options box click on the Units tab.  Scroll down to the Rainfall 
Intensity and ensure that it matches the units in the IDF file. Click OK. 
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SECTION 4 – DRAINAGE COMPUTATION

Setting Global Storm Events and Alternatives

Drainage and Utilities calculations are run on groups of settings 
called Scenarios, which have distinct subgroups of settings focused on aspects of 
drainage design or analysis.  The subgroups are called Alternatives and include 
scopes as Physical Alternative, Design Option Alternatives and Rainfall 
Runoff Alternatives (focus here).  Each Rainfall Runoff Alternative points to 
a Storm Event selected from the Storm Data collection (the IDF-Table imported 
previously). 

Bentley discusses scenarios in more detail and has information available on 
the Bentley Learn Server - ORD CE - 09 - Drainage Modeling and ORD CE – 10 
– Drainage Hydraulics learning path. 

Storm Events used for analysis and design of storm drainage systems are 
usually:   

 10-year for the drainage system 
 50-year for sag condition 

1.  Select the Components tab, click on Storm Data, click on Storm Data.   Select 
project specific alternative.  

2.  Select the Analysis tab, these tools are combined to calculate and report on the 
drainage scenarios.   

As shown in Section 1 - Introduction and Tools, the Analysis tab is split into 
three (3) sections: Calculation, Analysis Tools and Analysis Views.  Most tools in 
the Calculation section are also available in the Compute Center box from 
the Analysis Tools section.

Select the Scenarios icon, there are two Scenarios: Base Design and Base 
Analysis.

Base Design will resize pipes, change inverts to Default Design Constraints. This 
option is not recommended.



32 

Base Analysis will not resize pipes or change inverts but will check if pipes and 
inverts conform to Default Design Constraints.  Any discrepancies will be shown in 
‘User Notifications’ after verified or computed. (Recommended)

1.  Click on 
the Scenarios icon for the 
Scenarios box to open. 
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2.  Select the Base 
Analysis, right-
click and click on Properties, 
click on the Drainage tab in 
properties. 

3.  Click on Physical, click on the down arrow next to Base Physical 
and click <New…>.

4.  In the Create New 
Alternative box enter a new 
rainfall alternative for your 
Project: Full Capture, 
click OK. 

You will NEED BOTH Full Capture and Spread Calculation scenarios. The Full 
Capture calculation is to determine the size of the pipes whereas the Spread 
Calculations are to ensure we don’t exceed maximum spread on roadway. 
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5.  Select the Base Analysis you want to run, example: Zone 4 - 50-yr.  as well as 
Physical Scenario, Example: Full Capture. Close the properties box.  Close the 
Scenarios box.

6.  Select the Components tab, click on Global Storm Events.  There are now 
additional alternatives.

7.  Select the Analysis tab and select the Scenarios icon.  Right-click on Base 
Design and select Properties.  Click on the Drainage tab. 

8.  Change the Rainfall Runoff to the Base Analysis as previously.   

9. Select zone, year, right click 
and select Make Current

The current process will have a 
red check box 

This is the minimum preparation needed to Compute the storm drainage system(s) 
for a project. 

10. Once Computed with Catalog inlets. 
Repeat calculations with the Full 
Capture Scenario. 

For full capture: open the MDOT Inlet 
Spacing Flex Table, right click on Inlet
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Type select Global Edit change the 
value to Full Capture 
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Validate

The Validate command is in the Analysis tab – Calculation section and within 
the Compute Center menu box.  The Validate command will run a diagnostic check 
on the network data (drainage system) and alert you to possible problems that could 
be encountered during the calculations.  This is a manual validation and checks only 
for input data errors.  The Compute command is the automatic validation that 
Drainage and Utilities runs when it is initiated, and it will check for input data errors 
and for network connectivity errors as well as many other things beyond the manual 
validation checks.  It is a good idea to first check (validate) the drainage system for 
any input data errors or missing items/data especially when there is a large 
system.  This may need to be done multiple times, because some errors may be 
hidden after the initial validation

Click on 
the Validate command, you 
will/may get a message for 
errors or warnings: Click OK. 

After the validation is 
complete you will typically 
see two different kinds of 
error markers in your 2D view 
window (usually View 1, 
Default). 

Click on Notifications or the User Notification icon in the Compute Center.

The notifications window will come up displaying a list of warnings generated during 
the validation process. There are two types:



37 

Red error must be corrected 
before the model (system) can be 
computed. 

Yellow does not prevent 
successful calculation of the 
model, but element does not meet 
certain criteria. 

In the user Notification box, you will see messages with 
the RED and/or YELLOW icon as well as a toolbox (see below).

Computation and Results

You are ready to compute after all RED issues are resolved and all YELLOW issues 
are modified or considered.

1. Click the Compute icon. Located in the Analysis Tab

Drainage and Utilities will run the calculations, you will see window(s) pop-up, wait 
until the GVF-Rational Calculation Summary box opens.
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2.  Calculations were successful if you see: Convergence was achieved in the 
Calculation Executive Summary box.

3.  Click on Messages… to see the newest User Notifications, if there is an error, the 
calculations will stop at that point, you will have to solve the error and rerun 
calculations.

4. Click on Report and for the Scenario Summary preview, this can be printed.

5.  Click Details… the Calculation Detailed Summary box will open showing:  

 Calculation Options
 Catchment Summary
 Link Summary
 Node Summary
 Inlet Summary
 Pond Summary

6.  Click on Report to get one combined report to review/print/save.  For individual 
and more complex reports use Flex Tables.

Flex Tables

Drainage and Utilities shows the engineering data in tabular format called Flex 
Tables.  The most common flex tables have been established as MDOT Flex 
Tables and have been formatted for Nodes, Links and Culverts.  Any flex table can be 
edited to best fit the project.  The designer should use the drainage manual as a guide 
to determine the information needed to represent the drainage system.

Drainage and Utilities has ‘predefined tables’ set-up that can be edited as 
needed.  Expand the Tables – Hydraulic Model folder, Flex Tables are available for 
use and are formatted to show all information and data required.  Should you have to 
edit to reflect information/data needed for the drainage computations, they still can be 
edited as needed specific to the project. Copy the flex table and rename project 
specific.

Export to File…— creates a text or csv file to work within Excel or shape file if 
needed.

Edit… — allows columns to be added or removed from the flex table

Zoom To…— highlight a row and click on Zoom To, the active view will zoom in to 
the item/row selected and is highlighted.

Report… — creates a report that can be printed.  Paper size and page set-up can be 
edited in the report page.
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Options...— gives the ability to create selection sets.

The Flex tables built into the workspace provide an output that allows a clearer review 
process from MDOT reviewers.
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MDOT HGL Table 



41 

MDOT Inlet Spacing Table 



42 

MDOT Sewer Table 


